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Icons 
 
 

Icon Meaning 
 

Caution 
 

Example 

 
Note 

 
Recommendation 

 
Syntax 

 
 
 
 
 

Typographic Conventions 
 
 

Type Style Description 
  

Example text Words or characters that appear on the screen. These include field 
 names, screen titles, pushbuttons as well as menu names, paths and 
 options. 

 Cross-references to other documentation. 

Example text Emphasized words or phrases in body text, titles of graphics and tables. 

EXAMPLE TEXT Names of elements in the system. These include report names, 
 program names, transaction codes, table names, and individual key 
 words of a programming language, when surrounded by body text, for 
 example, SELECT and INCLUDE. 
 
Example text 
 

 
EXAMPLE TEXT 
 
 
Example text 

 
<Example text> 

 
Screen output. This includes file and directory names and their paths, 
messages, source code, names of variables and parameters as well as 
names of installation, upgrade and database tools. 
 
Keys on the keyboard, for example, function keys (such as F2) or the  
ENTER key. 
 
Exact user entry. These are words or characters that you enter in the 
system exactly as they appear in the documentation. 
 
Variable user entry. Pointed brackets indicate that you replace these 
words and characters with appropriate entries. 
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SAP Social Intelligence Data Harvesting from 
Twitter: Configuration Guide 

 

1 Purpose 
 
The purpose of this document is to describe the general configuration steps required to 
manually set up the configuration within the system landscape that has already been 
installed using the corresponding installation or configuration guides for installation. 
 

 

1.1 Overview 
 
This integration package implements an integration of social media channel into SAP 
Social Intelligence. It allows you to load and analyze social media data from Facebook and 
Twitter into SAP Social Intelligence system. 
 
This integration package runs on the SAP HANA Cloud Integration (HCI) tenant and 
connects to the SAP Social Intelligence system through OData service. The APIs from 
Facebook and Twitter are connected with the new Facebook and Twitter HCI adapters. 

 
The following figure illustrates the integration flow: 
 
 
 
 
 

Twitter 
 
 

SAP HCI 

 
Facebook 

 
 
 
 
 
 
 
 
 
 
 
 
OData 

 
 
 
 
 
 
 
 
 
 

 
SAP Social  
Intelligence 

 
 
 
 
 

2 Preparation 

 

2.1 Prerequisites 
 
Before the integration content can be configured and used in your SAP HCI tenant, the API 
configuration for the social media channels needs to be done. These steps need to be done 
in the Twitter or Facebook account. Please keep in mind that the step order or buttons/links 
can have different description as mentioned in the chapters below. Twitter and Facebook can 
change their documentation and processes so it might be necessary to check their 
documentation how to set up the API access in the correct way. 

 
Please also make familiar how to get and start with SAP HCI usage: 
 
 https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2  
015.07_CORR/en-US/frameset.html?60359ca5fa9545149d279494320b6a5a.html 
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2.2 Social Media Channels 
 
Use 
 
To describe the general steps required to request the key or token required for 
authorization of social media channel APIs. 
 

 
Some social media channels often change their web page and process to get 
the needed keys and tokens. The following descriptions are based on their 

web pages and processes as on March 1st, 2015.  
To create an account and to register as developer, you need to have a valid 
email address. 

 
On some social media channels, you also need a valid (mobile) phone number to 
validate your address. For more information, please refer to the official web page of 
the related social media channel. 

 

2.2.1  Apply Authorization for Twitter API 1.1 
 

Procedure  
1. Go to the Twitter developer site (for example,  https://dev.twitter.com/)  

 
2. Choose Manage Your Apps link under TOOLs group (at bottom of the web page)  

 
3. Log on with your Twitter account or create a new account by choosing the Sign in link  

 
4. Choose Create New App  

 
5. Fill out the form. For Sentiment Intelligence all fields are only needed internally 

for administration purposes  
 

a. Name: Any name that identifies this Application  
 

b. Description: Any Information of this Application  
 

c. Website: Your application's publicly accessible home page  
 

d. Callback URL: Optional  
 

6. Read and accept the Developer Agreement by selecting the Yes I agree checkbox  
 

 
Be aware that you have registered a mobile number in your user’s profile 
settings. Without a mobile number, you are not able to register an app. 

 
7. Submit the form by choosing Create your Twitter application. 

An application is created and registered.  
 

8. Choose Keys and Access Tokens tab, your Consumer Key and Consumer Secret 
are created; note them down for further configuration steps  

 
9. In Your Access Token section under Token Actions, choose Create my access 

token button.  
 

Your Access Token and Access Token Secret are created; note them down for 
further configuration steps. 
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2.3 SAP Social Intelligence System Information 

 
The user needs to have the following requirements:  

 SAP Business Suite Foundation 748 SPS01 onwards 


 SMI_AUTH authorization should be added to user role to view and consume social 
data models. Below are the steps required to assign SMI_AUTH authorization to 
your user role: 


1. To start role maintenance, either choose Create Role in the SAP Easy Access 

Menu -> Tools -> Administration -> User Maintenance -> Role Administration ->   
Role or go to transaction PFCG.  

 
2. Enter the name of the role (for example, SMI_ROLE) and Choose Create. 

Enter the role description, for example, the activities contained within it.  
 

3. Choose the Authorizations tab to generate the profile for the role.  
 

4. Under the Edit Authorization Data and Generate Profiles section, choose 
Change Authorization Data. A Choose Template dialog box opens. Select the Do 
not select templates button.  

 
5. Choose the Manually icon from the icon bar. A Manual selection of 

authorizations dialog box opens.  
 

 Enter the authorization object SMI_AUTH in the dialog box. The system 
automatically maintains the authorization fields of the role. 


6. Maintain the authorization values by expanding the object classes and click 

on the white field to the right of the authorization field name.   
7. Select the authorization values as Create, Change, Display, and Delete. Choose  

Save.  
 

8. Generate an authorization profile for the authorizations. To do this, Choose  
Generate.  

 
 You are prompted for an authorization profile name. A valid name in 

the customer namespace is proposed. 
9. Save your entries.  

 

3 Configuration 
 
The SAP Social Intelligence Data Harvesting from Social Media Channels 
integration package consists of the three iFlows: 
 

1) OData Integration Flow for Subjects  

 

In this iFlow, OData stores the parameters required to read the subjects defined in 
the SAP Social Intelligence system.  

 
2) OData Integration Flow for Social Posts  

 
In this iFlow, OData stores the parameters required to create the social post entries 
in the Social Intelligence application tables.  

 
3) Integration Flow for Harvesting Twitter Data  

 
You use this iFlow to harvest the Twitter data into the Social Intelligence receiver 
system. In this iFlow, you will set up the Twitter credentials. 

 
The configuration is structured in the following order:  
 Installation and configuration of Eclipse Integration Designer 
 Deployment of Credentials 
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 Deployment and configuration of the SAP Social Intelligence Data Harvesting from 

Social Media Channels package. 

 

3.1 Installation and configuration of 
Eclipse Integration Designer  

 
1. Download the Eclipse  

 

Go to the URL  http://www.eclipse.org/downloads/packages/release/Luna/SR2 to 
download the Eclipse IDE for Java EE Developers. (Choose the appropriate 
version according to your operation system e.g. Windows 32-bit/Linux 64-bit)  

 

The following is the main Luna packages site.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Unzip the downloaded file to your folder. 

 
 
 

3.1.1  Install HCI Add-on 

 
1. Open the Eclipse.   
2. In the Welcome page, open the Developer's Workbench.  

3. From the main menu, choose Help Install New Software...   
4. In the Available Software page of the Install wizard, add the update site 

URL https://tools.hana.ondemand.com/luna.   
5. Select the SAP HANA Cloud Integration Tools category.   
6. Check that the following three options are checked:  

 

 Show only the latest version of available software 
 Groups items by category 
 Contact all update sites during install to find required software. 
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7. Choose Next.   
8. Check the following features selected for installation and choose Next. 

SAP HANA Cloud Integration Tools:   
o Adapter SDK for SAP HANA Cloud Integration 
o Designer For SAP HANA Cloud Integration  
o  Operations for SAP HANA Cloud Integration  

9. Accept the terms of licensing agreement and choose Finish.   
10. Restart the Eclipse IDE.  

 

3.1.2  Add HCI Perspectives 
 
A perspective is useful in organizing various eclipse views around the editor area, 
these are also helpful in managing menus and toolbars. The SAP HCI Add-On provides 
2 perspectives: 
 

 Integration Designer: The Integration Designer perspective provides integration 
tools on the Eclipse platform to model integration flows, configure attributes of 

the integration flows, and deploy them to the runtime. 


 Integration Operations: The Integration Operations perspective provides 
functions for performing administrative tasks related to SAP HANA Cloud 

Integration (SAP HCI) runtime clusters and to message monitoring. 
 
To add both perspectives:  

1. In the main menu, choose Windows Open Perspective  Other... .   
2. In the Open Perspective dialog, select the Integration Designer   
3. Choose OK.   
4. In the main menu, choose Windows  Open Perspective  Other... .   
5. In the Open Perspective dialog, select the Integration Operations.   
6. Choose OK.  
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You can now switch perspective by choosing Integration Operations or Integration 
Designer in the top right. 
 
 

 

3.1.3  Eclipse HCI Connection Setup 
 
Once the HCI add-on for Eclipse is installed, you can use it to connect to HCI tenant, in 
which you can do development as well as tenant management. 
 

1. To carry out the activity, you should go to the Eclipse with the HCI add-on.  

2. For Windows/Linux:Select Menu item Window  Preferences.  

For Mac OS X:Select Menu item Eclipse  Preferences (Mac OS X).  
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3. On the Preferences screen, Select SAP HANA Cloud Integration Operations 

Server   
Enter the server URL, User and Password for Operations Server.  
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4. Choose Test Connection. The following screen shows up if connection to Operations 

Server is good.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If you get Version Mismatch prompt, go to chapter 2.1.2 to have the latest Add-
on installed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Save the Operations Server by choosing OK twice. Switch to the Integration 

Operations Perspective. In the Node Explorer window, the newly connected 
Operations Server will be shown.  

 
 
 
 
 
 
 
 
 
 
 
 

If you cannot see the window you can choose Window  Show view  Other 
and then type filter text Node Explorer to open the Node Explorer window. 
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3.2 Deployment of Keystores 

 
Now you will deploy the Twitter or Facebook credentials via Eclipse. For communication 
with your S/4 HANA Cloud Marketing system you also need to deploy the user/password as 
User Credential Artifact on your HCI tenant. 
 
 

3.2.1  Deploy Twitter credentials 

 
In chapter  2.2.1 of this guide you have created the following:  

 Consumer Key 
 Consumer Secret 
 Access Token 
 Access Token Secret 



1. To carry out the activity, open your SAP HCI tenant WEB UI 
(e.g. https://<your SAP HCI tenant URL>/itspaces)  

 
2. In the tenant menu choose Monitor.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the Security Material 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. Click on Add. 
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5. Select Secure Parameter 

 
 
 
 
 
 
 
 
 
 
6. Enter the following values: 

 

Field Name Entry Value 
  

Name* TWITTER_CONSUMER_KEY 
  

Description  
  

Secure Parameter* Example: AuRMrj8kjasdMMaLsfoEVasANNKs6 
  

Repeat Secure Example: AuRMrj8kjasdMMaLsfoEVasANNKs6 
Parameter*  

  

 
7. Click on Ok.  

 
8. Repeat step 4-7 for TWITTER_CONSUMER_SECRET, 

TWITTER_ACCESS_TOKEN and TWITTER_ACCESS_TOKEN_SECRET.  
 
 
 

3.2.2  Deploy OData User data with a Secure Parameter 

 
In chapter  2.3 of this guide, you created a role and assigned to your user in the SAP 
Business Suite Foundation system. This user credentials needs to be stored now in your 
HCI tenant as Secure Parameter. 

 
1. To carry out the activity, open your SAP HCI tenant WEB 

UI (e.g. https://<your SAP HCI tenant URL>/itspaces)  
2. In the tenant menu choose Monitor.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.  Click on the Security Material 
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4. Click on Add.  

 
 

 

5. Select User Credential  
 
 
 
 
 
 
 

 
6.  Enter the following values: 

 
 

Field Name Entry Value 
  

Name* Example, erp_user 
  

Description  
  

User* <User Alias Name of your technical user> 
  

Password <Password of your technical user> 
  

 
7. Click on Ok.  

 

 

3.2.3 Deploy HCI tenant User data with a Secure Parameter  

 
These user credential need to be deployed for usage in the Twitter Integration IFlow. The 
Username & password for this user are your credentials to logon to the HCI Web UI and 
your HCI tenant. 

 
1. To carry out the activity, open your SAP HCI tenant WEB 

UI (e.g. https://<your SAP HCI tenant URL>/itspaces)  
2. In the tenant menu choose Monitor.  
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3. Click on the Security Material 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. Click on Add.  
 
 
 
 
5. Select User Credential  
 
 
 
 
 
 
 

 
6. Enter the following values: 
 

 Field Name Entry Value 
   

 Name* TWITTER_HCI_SERVICE_USER 
   

 Description Enter the description 
   

 User* <your_user_name_for_the_HCI_tenant> 
   

 Password <Your_SCN_Password> 
   

7.  Click on Ok.  
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3.3 Deployment and configuration of the SAP 
Social Intelligence Data Harvesting from Social 
Media Channels Package  

 

3.3.1 Deployment of the OData IFlow for Subjects  

 
In this iFlow, you need to configure the Receiver parameters of your SAP Social 
Intelligence system. 
 

1. In your preferred web browser navigate to the integration catalog hub 
page:  https://cloudintegration.hana.ondemand.com/  

 
2. Search for the SAP Social Intelligence Data Harvesting from Social Media 

Channels package.  
 

3. To copy integration package in catalog to your customer workspace, mouse-over the 
integration package tile and choose the “Copy to Workspace” button.  

 
 
 
 

 
4. In Design tab page, select the SAP Social Intelligence Data Harvesting from Social 

Media Channels integration package that contains OData IFlow for Subjects.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. You see an overview of all the artifacts available in the selected integration package.  

 

6. In the Actions column for the integration flow OData IFlow for Subjects, choose   
Configure.  

 

7. Enter the relevant details on the Sender tab page   

Field Name Entry Value 
  

Sender Sender 
  

Adapter Type SOAP 
  

Address Example: </twitter_soap_endpoint_subject> 

 You have to enter different addresses for different set ups. 
  

 
 

 
© SAP SE Public Page 17 of 26 

https://cloudintegration.hana.ondemand.com/


SAP Social Intelligence Data Harvesting from Twitter: Configuration Guide 
 

 
8. Provide the relevant details on the Receiver tab page:  

Field Name Entry Value  

Receiver SMI 

Adapter Type OData 

Address Example: 
https://<hostname:port>/sap/opu/odata/sap/SOMI_DEFINE_SUBJECT 

 

(The above link to the OData Service is used to read the 
subjects/keywords configured in SAP Social Intelligence system) 

Host Example: <host name of SAP Social Intelligence system> 

Port Enter the port number 

Client Enter the client number 

Authentication 
Type 

Basic Authentication 

Credential Name Example, SMI_Credential (see this chapter) 

 
9. Go back to the package content view.  

 
 
 
 
 
 

10. In the Actions column for the OData IFlow for Subjects, choose Deploy.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.3.2 Get the Link of the Deployed OData IFlow for Subjects 
 
For proper configuration of the Configuration IFlow for Subjects, the correct link to the 
OData IFlow for Subjects is required. For this, you need to check this in the Monitoring tab 
of your HCI tenant Web UI. 
 

1. In the WEB UI of your HCI tenant go to the Monitor tab.  
 

2. In the Manage Integration Content section select the tile with status Started.  
 

3. Search for the OData IFlow for Subjects and click on the Started (1) link in column   
Status.  

 
4. Note down the Endpoints link for the next step.  
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3.3.3 Deployment of the OData IFlow for Social Posts 

 
In this iFlow, you need to configure the Receiver parameters of your SAP Social 
Intelligence system. 
 

1. In your preferred web browser navigate to the integration catalog hub 
page:  https://cloudintegration.hana.ondemand.com/  

 
2. Search for the SAP Social Intelligence Data Harvesting from Social Media 

Channels package.  
 

3. To copy integration package in catalog to your customer workspace, mouse-over the 
integration package tile and choose the “Copy to Workspace” button.  

 
 
 
 

 
4. In Design tab page, select the SAP Social Intelligence Data Harvesting from Social 

Media Channels integration package that contains OData IFlow for Social Posts.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. You see an overview of all the artifacts available in the selected integration package.  

 

6. In the Actions column for the integration flow OData IFlow for Social Posts, choose   
Configure.  

 

7. Enter the relevant details on the Sender tab page  

 

Field Name Entry Value 
  

Sender Sender 
  

Adapter Type SOAP 
  

Address Example: </twitter_soap_endpoint_socialpost> 

 You have to enter different addresses for different set ups. 
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8. Provide the relevant details on the Receiver tab page: 

Field Name Entry Value  

Receiver SMI 

Adapter Type OData 

Address Example: 

https://<hostname:port>/sap/opu/odata/sap/ SOMI_SOCIAL_API_SRV 

 

(The above link to the OData Service is used to create the social post 
entries in SAP Social Intelligence tables) 

Host Example: <host name of SAP Social Intelligence system> 

Port Enter the port number 

Client Enter the client number 

Authentication 
Type 

Basic Authentication 

Credential Name Example, SMI_Credential (see this chapter) 

 
9. Go back to the package content view.  

 
 
 
 

 

10. In the Actions column for the OData IFlow for Social Posts, choose Deploy.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3.4 Get the Link of the Deployed OData IFlow for 
Social Posts  

 
For proper configuration of the Configuration IFlow for Social Posts, the correct link to the 
OData IFlow for Social Posts is required. For this you need to check this in the Monitoring tab 
of your HCI tenant Web UI. 
 

1. In the WEB UI of your HCI tenant go to the Monitor tab.   
2. In the Manage Integration Content section select the tile with status Started.  

 
3. Search for the OData IFlow for Social Posts and click on the Started (1) link in column   

Status.  
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4. Note down the Endpoints link for the next step. 

 
 

3.3.5 Deployment of the IFlow for Harvesting Twitter Data  
 
In this iFlow, you harvest the twitter data into SAP Social Intelligence receiver system. In this 
iFlow, you will set up the Twitter credentials. 
 

1. In your preferred web browser navigate to the integration catalog hub 
page:  https://cloudintegration.hana.ondemand.com/  

 
2. Search for the SAP Social Intelligence Data Harvesting from Social Media 

Channels package.  
 

3. To copy integration package in catalog to your customer workspace, mouse-over the 
integration package tile and choose the “Copy to Workspace” button.  

 
 
 
 

 
4. In Design tab page, select the SAP Social Intelligence Data Harvesting from Social 

Media Channels integration package that contains IFlow for Harvesting Twitter Data.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. You see an overview of all the artifacts available in the selected integration package.  

 

6. In the Actions column for the integration flow IFlow for Harvesting Twitter Data, 
choose Configure.  

 

7. Provide the relevant details on the Receiver tab page:   

Field Name Entry Value 
  

Receiver Twitter 
  

Adapter Type Twitter 
  

Consumer Key Alias TWITTER_CONSUMER_KEY (See  chapter 3.2.1) 
  

Consumer Secret Alias TWITTER_CONSUMER_SECRET (See  chapter 3.2.1) 
  

Access Token Alias TWITTER_ACCESS_TOKEN (See  chapter 3.2.1) 
  

Access Token Secret TWITTER_ACCESS_TOKEN_SECRET (See  chapter 3.2.1) 
Alias  
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8. Change the Receiver field to User and provide the relevant details on the 

Receiver tab page:   
Field Name Entry Value 

  

Receiver User 
  

Adapter Type Mail 
  

Address < your mail server > 
  

From < your From: E-mail address > 
  

To < your E-mail address > 
  

 
9. Change the Receiver field to OData_IFlow_Subjects and provide the relevant 

details on the Receiver tab page:   

Field Name Entry Value 
  

Adapter Type HTTP 
  

Receiver OData_IFlow_Subjects 
  

Credential Name <your_HCI_credentials> (see this  chapter ) 
  

 
10. Change the Receiver field to OData_IFlow_SoclPost and provide the relevant details 

on the Receiver tab page:   
Field Name Entry Value 

  

Adapter Type HTTP 
  

Receiver OData_IFlow_SoclPost 
  

Credential Name <your_HCI_credentials> (see this  chapter ) 
  

 
11. Switch to the Scheduler tab.  
 
12. Set the frequency for the automatic iFlow run. (E.g. once or every hour)  
 
13. Switch to the Parameters tab.   
14. Here you can maintain your Twitter search keywords.   

Field Name  Entry Value 
    
Social Media Channel Example: TW 
Code  

 You use this parameter to filter the subjects configured for this 
 channel (twitter). 
  

EndPoint_url_subjects <OData iFlow for subjects URL from chapter  3.3.2> 
  

EndPoint_url_socialposts <OData iFlow for social posts URL from chapter  3.3.4> 
 
 
15. Click on Save.  
 
16. Go back to the package content view.  
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17. In the Actions column for the IFlow for Harvesting Twitter Data, choose Deploy. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The deployment fails for the following reasons: 

 
o The IFlow for Harvesting Twitter Data is deployed for the first time.  

 

This is because the iFlow needs to initially create the data store SMI_SinceID 
for storing the SinceID of the keyword or subject. For this reason, you need to 
deploy this iFlow once again.  

 
o A new subject or keyword is configured for the first time in the SAP 

Social Intelligence system.  
 

This is because the SinceID is not found in the data store SMI_SinceID for 
the newly created subject or keyword.  

 

18. (Click on Deploy again)  
 

19. Now the monitoring should show the successful start of the IFlow for 
Harvesting Twitter Data. The status should be “COMPLETED.”  

 

 

3.4 Troubleshooting & Log  
 
In the SAP HCI WEB UI you have the opportunity to analyze the deployed integration flows 
in the Monitoring section. 

 
1. To carry out the activity, open your SAP HCI tenant WEB 

UI (e.g. https://<your SAP HCI tenant URL>/itspaces)  

 

2. In the tenant menu choose Monitor  
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3. On the overview screen choose the tile with a message status you want to analyze 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. On the left side, select you integration flow you want to analyze.  
 
5. In the Log tab you can switch between different log file. (Log, Audit, Tweets, Payload)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Log tabs Audit, Tweets & Payload are available in the Integration Flow 
for Harvesting Twitter integration flow only. 

 
6. In the showed example the error indicates that a Timeout occurred in the http adapter  
 
7. This could occur for example because of a slow network connection. A 

possible solution could be to increase this timeout value.  
 
8. For this open the Integration flow for Harvesting Twitter Data integration flow in the 

SAP HCI WEB UI Design section  
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9. Switch to Edit Mode.  
 
10. In the Integration flow select the http Adapter and select then the Adapter 

Specific parameters.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
© SAP SE Public Page 25 of 26 



SAP Social Intelligence Data Harvesting from Twitter: Configuration Guide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
11. Increase the Timeout value.   
12. Save and Deploy.  
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